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"Learn about j-Tree

More than beauty and shade, trees work hard for us all. Explore how trees
improve the environment in communities big and small, urban and rural...

even in your own backyard!

What benefits do trees provide? ©)
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Today’s 1-Tree Core Topics

I. Design, MyTree, Species, Planting

1. Landscape, County

[11. Canopy

1VV. Eco, Harvest

V. Application (CO FAP, Citizen Science)



Core Tools and Utilities
Core Tools i-Iree

Al '\hl-\!\

These are the flagship tools for i-Tree, listed by ease-of-use.

1-Tree MyTree

i-Tree Landscape

1-Tree Design

1-Tree Canopy

1-Tree Eco

Powered by i-Tree
We are lucky to have many partners using i-Tree in their own projects.
® County Tree Benefits
® (GHG Planting Calculator (also know as i-Tree Planting)

® Harvest Carbon Calculator (formerly known as PRESTO)

Utilities
These smaller tools supplement i-Tree.

® |-Tree Species

https://www.itreetools.org/tools
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i-Iree.

ACADEMY

i-Tree Tool Selection Framework

* My objectives?

» Tool advantages,
limitations, and options?

* Available resources?

* Technical capacity or
skillset?

* Timeline?
* Audience?

* What does success look
like for me?

UTILITIES
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ECO: Tree/Population Design:
Ecosystem Services Local-scale
Calculator management

Landscape:
Regional-scale
management

i-Tree Tools & Model Relationships

i-Tree Academy PPT Slide



Which Tool Should | Use?

May 12, 2020

For forests and many trees: ACADEMY

e i-Tree Eco (desktop app) Flagship tool that quantifies the structure of, threats to, benefits, and values provided by forest populations globally.

® i-Tree Projects (web app) An online platform for sharing results and data from i-Tree Eco assessments. Currently in beta - additional projects
coming soon!

e i-Tree Landscape (web app) Rapidly assess human and forest population information; threats to help prioritize areas for tree planting;
protection.

® i-Tree County (web app) Quickly learn the numerous benefits that trees provide within your county.

® i-Tree Canopy (web app) Easily estimate tree canopy and benefits using aerial photographs. see Canopy report example

For individual and small amounts of trees:

® i-Tree Design (web app) Parcel level analysis of current and future tree benefits.
® i-Tree MyTree (web app) Easily assess the value of one to several trees in a mobile web browser.

For effects on stream flow & water quality:

e |-Tree Hydro (desktop app) Quantify the effects of tree canopy and impervious cover on water quantity and quality.

For recommendations on what species to plant:

e i-Tree Species (web app) Determine the best species that meet your desired benefits.

For benefits of new tree planting projects:

e i-Tree Planting (web app) Estimate the long-term environmental benefits from a tree planting project.

For carbon stored in harvested wood products:

e i-Tree Harvest (web app) Estimate the amount of carbon stored in harvested wood products.

https://www.itreetools.org/tools/which-tool-should-i-use
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i-Iree.

. Design, MyTree, Planting, Species

For individual and small amounts of trees:

e i-Tree Design (web app) Parcel level analysis of current and future tree benefits.
e MyTree (web app) Easily assess the value of one to several trees in a mobile web browser.

For recommendations on what species to plant:

® i-Tree Species (web app) Determine the best species that meet your desired benefits.

For benefits of new tree planting projects:

® -Tree Planting (web app) Estimate the long-term environmental benefits from a tree planting project.

https://www.itreetools.org/tools/which-tool-should-i-use
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i-Iree

ACADEMY

|. Design, MyTree, Planting, Species

I-Tree Design .o

i-Tree Design allows anyone to make a simple estimation of the
benefits provided by individual trees., With inputs of location, species,
tree size, and condition, users will receive an understanding of tree
benefits related to greenhouse gas mitigation, air quality
improvements, and stormwater interception. With the additional step
of drawing a building footprint — and virtually "planting” or placing a
tree - tree effects on building energy use can be evaluated.

Tree benefits are estimated for (a) the current year, (b) a user-
specified forecast year sometime in the future, (c) the projected total
benefits across that future timespan, and (d) the total benefits
provided to date (based on estimated tree age). Multiple trees and
buildings can be added to compare benefits or to provide a full
accounting of a property's trees.

This tool is intended as a simple and accessible starting point for
understanding the value of individual trees or a small population of
trees to a community. For more detailed information on urban and
community forest assessments, please explore more of the i-Tree
website. To learn more about the i-Tree Design model, click here.

i-[ree

Design

@ Laptop users (mouse) () Tablet users (finger taps)

Enter a street address below to get started.:

3843 Laporte Ave. Fort Collins, CO 80521 |

Gol

-or-

Load Previously Saved Project

Use of this tool indicates you accept our EULA,




Design — Let s get started! -

. . Start Over
| -T ree D es| g N v7.0 3843 Laporte Ave, Fort Collins, CO 80521, USA Save Progress

About
Get started with these easy steps: | {B 8 RN
1. Draw Structures Map  Satellite |
2. Place Trees

Please break large projects into smaller projects of no more
than 25 trees at a time.

Describe your tree:
e Tree species:

IThe David Elm ]

'U"U

« Tree diameter: 3| Inches v
or circumference: 9.4
e Tree condition: | Excellent v

e Tree exposure to sunlight: | Full sun v
Tree benefit zones:

e The colored zones surrounding the structure,
which appear as you describe your tree, illustrate
the relative monetary value of energy savings
that the tree would provide in each zone.

e Hover over each zone to see that energy benefit
information displayed below the map.

WMICHOCT—HN VCO<,OMMA—- DCO=<

To place a tree:
 Drag this icon [®] to the location on the map

where you would like to place your tree.
e Repeat to place additional trees.

\
Ll

e - 1 4 S8
Map data ©2021 Imagery ©2021, Maxar Technologies | Terms of Use | Reporta map ¢

e Hover over any tree you have placed on the map |[at 4058797 Bearing: 202 Tree: The David Elm (3 Inches) Energy Savings: $0.00
to display its benefits. |Lng: -105.14586 Distance: 37.3m (122.3ft) Total Savings: $0.17 kWh: 0.0 Therm: 0.0
Model the tree(s) future crown growth over Less desirable [T More desirable
time: Preferred planting zones to maximize tree benefits are shown around the structure
Model Crown Growth Zone colors are generic for all tree species and sizes. Benefit values will change

based on free and building characteristics and tree placement.




Design *

. . Start Over
| -T ree D esi g N vz.o 3843 Laporte Ave, Fort Collins, CO 80521, USA Save Progress
About

Get started with these easy steps:

1. Draw Structures ?
2. Place Trees ?
3. Estimate Benefits ?|

You can calculate the benefits of your tree(s)
for current and future years, as well as the
total to date.

Map  Satellite

=8

e Enter the number of years (2-99) below to
track tree growth and benefits. . Colorado State
Years: i ForestiService

Get your results! (save your project BEFORE calculating.
Large projects may fail during times of heavy demand. Saving

allows you to try again later!)
Calculate »

All Trees

#1 Ponderosa pine (DBH:10 inches, Condition:Excellent)
#2 Ponderosa pine (DBH:10 inches, Condition:Excellent)
#3 Blue spruce (DBH:5 inches, Condition:Excellent)
#4 Blue spruce (DBH:5 inches, Condition:Excellent)
#5 The David EIm (DBH:3 inches, Condition:Excellent)

NWMBCAHOCT—H VCO<,NMMIT- TCO<

247

imagery ©2

Lat: 40.58820



All Trees v
g .
#1 Ponderosa pine (DBH:10 inches, Condition:Excellent) :tup '
#2 Ponderosa pine (DBH:10 inches, Condition:Excellent) port

i-Tree Design v7.0 3843 Laporte Ave, Fort Collins, CO 80521, _ o
#3 Blue spruce (DBH:5 inches, Condition:Excellent)

#4 Blue spruce (DBH:5 inches, Condition:Excellent) sut
Display results for: |AII Trees v| #5 The David EIm (DBH:3 inches, Condition:Excellent)
(" Overall Benefits Stormwater Air Quality Carbon Dioxide

Your selected trees will provide overall benefits of $82 in the current year.
W Stormwvater W Air Guality
Owinter Savings W co2 While some functional benefits of trees are well documented, others are difficult to quantify
(e.g., human social and communal health). Trees' specific geography, climate, and
interactions with humans and infrastructure are highly wvariable and make precise
calculations that much more difficult. Given these complexities, the results presented here
should be considered initial approximations to better understand the environmental and
§23.33 economic value associated with trees and their placement.

O Summer Savings

Benefits of trees do not account for the costs associated with trees' long-term care and
maintenance.

$3.55 If these trees are cared for and grow, they will provide $77 worth of
$3.75 annual benefit in 50 years. See "Future Year (2071)" tab at left for details.
§0.37

S el oA Current Year (20217)

Breakdown of tree benefits

Total (2021-207 1)

Click on one of the tabs above for more detail

Total to Date
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Start Over
Return to Setup

H : View Report
i-Tree Desi gN v7.0 3843 Laporte Ave, Fort Collins, CO 80521, USA pprmt

Save Result
About

Display results for: All Trees v

Overall Benefits Stormwater Air Quality Carbon Dioxide

If they are cared for, these trees will provide a total of $4,089 worth of

B Stormewvater W i Quality overall benefits over next 50 years.
Ocoz W Wirter Savings _ _ ] . )
B Summer Savings B Total While some functional benefits of trees are well documented, others are difficult to quantify

(e.g., human social and communal health). Trees' specific geography, climate, and
interactions with humans and infrastructure are highly variable and make precise
5,000 calculations that much more difficult. Given these complexities, the results presented here
should be considered initial approximations to better understand the environmental and

Future Year (2071) " Current Year {2021)

% 4,000 - economic value associated with trees and their placement.
“
= 3,000 4 Benefits of trees do not account for the costs associated with trees' long-term care and
S maintenance.
8 2,000 -
i)
é 1.000 i 40 000 ~/
£ 35,000
5 U 000
= 30,000
5| -1.000 4 . . : 1 J'
i 201 2033 2045 2057 2070 25000
E Year -
R . g;n,r_r;ru
l Breakdown of tree benefits £
f_E 15,000
2| Click on one of the tabs above for more detail
; 10,000 4
T 5,000 1
A ——w—v—/
0 0-
E Saquestered Avolded
- . .
o Over the next 50 years, these trees will reduce atmospheric carbon

dioxide (CO2) by a total amount of 51,851 pounds.




esign, MyTree - Reports

i-Tree Designvz.o
Tree Benefit Report - 05/28/2021 € Ratum o My Tree List
3843 Laporte Ave, Fort Collins, CO 80521, USA

1ITe€ Trees Evaluated: 5

MyTree Benefits

Dt Lome o Chevn! L, 7Utcy devicteng)
Yurving Sam 110 n1 et
Total Projected Benefits (2021-2071) - Over S o Casstdo: e
the next 50 years, based on forecasted tree o el <otz At el e ey s
gr‘t:’v::, i-Tree Design projects total benefits worth O Surmer Savings B Told P ™
« $38 of storm runoff savings by avoiding 4,275 5000 atantd Ot Moy w2
gallons of stormwater runoff (intercepting S Wister Prnse Avcatesd .
171,100 gallons of rainfall)
* $459 of air quality improvement savings by
absorbing and intercepting poliutants such as NaE Lo
ozone, sulfur dioxide, nitrogen dioxide, and e o
particulate matter; reducing energy production
needs; and lowering air temperature wten b
*$1,206 of savings by reducing 51,851 Ibs. of =
atmospheric carbon dioxide through CO2 o g 2 oL -r :
sequestration and decreased energy production o~ it -
needs and emissions S D
*$2 430 of summer energy savings by direct Figure 1 Tree benafit farecast kv 50 years -
shading and air cooling effect through
evapolranspiration Erwngy Luage fw Year® sk
* $-44 of winter energy savings by slowing down ity Bahaath =
winds and reducing home heat loss
Arsrdied ey SITascre s

o Rty Current Year - For 2021, i-Tree Design estimates
e sives BC0d. annual tree benefits of $81.67:
B Surner Savirgs * $0.37 of stormwater runoff savings by avoiding
41 gallons of stormwater runoff (intercepting
1,635 gallons of rainfall)
« $3.75 of air quality Improvement savings
» $23.33 of carbon dioxide reduction savings
« $50.68 of summer energy savings
* $3.55 of winter energy savings

Semadin an wntrnbenl Sneet onn B0 T el
St Hasnant s el wu Taaed Ay Sabern
1650 60 riy

L8 003 et R B S

Figure 2. Annua ree benefits for 2021 L5 bk Wi Sedanstmt tated £

A cooperalive intiative Detween.

n m! @Adx)rl)n Foundation 'M’ I“i "P'

it Yvosx &eelools arg told




Planting p

Welcome to the i-Tree Planting Calculator! ..,

The i-Tree Planting Calculator is designed to help you estimate the long-term environmental benefits from a tree planting
project. The focus is on greenhouse gases, but many co-benefits are included.

This is a newly updated version of i-Tree Planting. Please clear your web browser's cache for this site before using.

Users enter the following information:

Tree species °

Size of trees at planting I-Tree
Information on the distance and direction to the nearest building (optional)
Information about the tree's growing conditions

Estimated mortality (optional)

The number of trees with each configuration

Project lifetime (number of years)

Specific greenhouse gas values (optional) Use of this tool indicates

Planting

acceptance of the EULA.
The following information is calculated (in units and associated dollar values) for the project life time: _

Greenhouse Gas (GHG) sequestered and avoided (owing to reductions in energy use)
Energy conserved

Air pollutants captured and avoided

Stormwater filtered

Tree total biomass




Planting p

Project Report - i-Tree Planting Calculator,; ;,

Location: Fort Collins, Colorado 80525 .
Electricity Emissions Factor: 1,736.73 pounds CO2 equivalent/MWh l'Tree.
Fuel Emissions Factor: 185.89 pounds CO2 equivalent/MMBtu Fating
Lifetime: 50 years

Tree Mortality: 10%

All amounts in the tables are for the full lifetime of the project.
Units
@ English (pounds & tons; KVWh & MMBIy; gallons) O Metric (kilograms & metric tons; KVyh & MMBI{y; cubic meters)

Copy Export CO, @ Energy Eco Air Pollution Search:
Location CQ, Benefits
I: £ eie)) feie)) feie?)
Group Avoided Avoided Sequestered Sequestered
Identifier = Tree Group Characteristics (pounds) (%) (pounds) (9)
1 » (1.0) EIm (Ulmus species) at 3.0 inches RDBH. -6,226.8 $-144.82 6,815.3 $158.50
» Planted 20-39 feet and south (180°) of buildings that were built post-1980 with heat
and A/C.

« Trees are in good condition and planted in full sun.




Species

Welcome to i-Tree Species!

i-Tree Species is designed to help urban foresters select the most appropriate tree species based on the species
potential environmental services and geographic area. Users select and rank the importance (0-10) of each
environmental service desired from trees. The program then calculates the best tree species based on the user-provided
weighting of environmental benefits of tree species at maturity.

Species are selected based on three types of information:

1. Hardiness — as determined by state and city. *
2. Mature height — user specified minimum and maximum heights. I.Tree

3. Environmental factors — ranked from 0 to 10:
o Air pollution removal Species

o Air temperature reduction
o Ultraviolet radiation reduction
o Carbon storage

Air Pollutant Removal (0-10 importance)
Rank each of the Tollowng eavironmental sarvices 11om 0 1010 on how Imponan! hese tree sesvices & ta you D = notimpodant. 10 @ Get startw

Loy = highly iImporiant
o Pollen allergenicity
o Building energy conservation Pollutant Removal Use of this tool indicates
® Cverall (O Speaftc acceptance of the EULA.

o Wind reduction
o Stream flow reduction (storm water managen overail raw

The combination of hardiness, mature height, and desire: &
suited for local use that maximizes environmental service:
as it will need to be whittled down to meet local needs » Sedect Overali 1o consater the overall 37 poliutant removatl Smpact of any tree (weights Mve politants based on the estmated effact of each

account as well. For more information and to learn abot PORABNS . e it s e e LN e
o IF YO WIS 10 TANK 118 DOMTENGS Iy uElly | SERCE SPeofc 1D e A IS e poiktants
SeCtion. o Rankng shaera 10 & most mponant whie chocsng 0 maans e poliufant Will not De CONSINEEG Qunng SOecks serclr

Other Functions (0-10 importance)

Loc vOC Emissices § Carson storage () viing Reduction ) Alr Temperature Reducton §))

UV Radiation Reduction o Buading Energy Reduction o Streamfiow Reduction ° Low Allsrgenicity °

» Eight addmcnal smaronmental funcnons can he consioered hane
o Clck e 7 Button [0 S0 3 085 f any function
« Rankrg shdans 10 s MOs2 MPOMant whike choosing O means e fRCIorn wik not De poesioerad duing speckes saacion




Species Report

Trees Recommended by i-Tree Species

i-TrcC

Start Over

This Is a list of the top 10% of tree species based on the following functions.

Generated: 5/28/2021
Location: Fort Collins, Colorado, United States of America

Hardiness: 5
Air Pollutant Rerconstraints:

Minimum Height: None o Maximum Height: None

Rank each of the followir °
= haghly important ) .
oy mpora Air Pollutant Removal (0-10 Importance)
e Overall 10
Pollutant Removal

Other Functions (0-10 Importance)

& Dverll _} Speceic

e LowWVOC:0 e UV Radiation Reduction: 0
overail Rate ) . - o

o Carbon Storage: 0 o Building Energy Reduction: 0

o Wind Reduction: 0 o Streamflow Reduction: 0

o Alr Temperature Reduction: 0 o Low Allergenicity: 0

o Select Overall o cons
poliuiant)

i-Tree.

§ = Sensitive | = Intermediate S/l = Indeferminate

TSUGA CANADENSIS
UV Radiation Reduction

EASTERN HEMLOCK

ULMUS AMERICANA AMERICAN ELM

LIRICDENDRON
« Eignt adaitionai envica TULIPIFERA

o Click e 7 button o scv

TULIP TREE 5~9

O UCIANIRAT BT SRy R AR

« Rankong skoers: 10 8 most inportant while choosing 0 means the facion will not be consiteras quing species selaction

]

s

R Species Sensitivity Pest Risk
. YOou wish 10 rank he
« Ranong sioers: 105 i Nitrogen  Sulfur
Scientific Name Common Name Ha_‘zrg:]”eess Invasive C}gg”)e Dioxide Dioxide | Possible Pests
(NO2)  (502)
Other Functions Fir Engraver, Southern Pine Beetle,
Loc VOC Emissions ° TSUGA MERTENSIANA  MOUNTAIN HEMLOCK 5~7 Western Spruce Budworm, Douglas-fir

Black Stain Root Disease

Hemlock Woolly Adelgid, Southern Pine
Beetle

Asian Longhomed Beetle, Dutch Elm
Disease, Winter Moth
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i-Iree

ACADEMY
l1. Landscape, County
For forests and many trees:
e i-Tree Landscape (web app)Rapidly assess human and forest population information; threats to help prioritize areas for tree planting;
protection.
e i-Tree County (web app)Quickly learn the numerous benefits thar trees provide within your county.

https://www.itreetools.org/tools/which-tool-should-i-use

I-Tree Academy

Online Training
i-Iree March 3rd — June 2nd, 2021



https://www.itreetools.org/tools/which-tool-should-i-use

|1. Landscape, County

i-Tree

ACADEMY

Welcome to i-Tree Landscape! ....

Offering more than just beauty and shade, trees provide intangible benefits, such as removal of atmospheric carbon
dioxide and pollution, stormwater reduction, temperature modification, and more. i-Tree Landscape allows you to explore
tree canopy, land cover, and basic demographic information in a location of your choosing. With the information provided
by i-Tree Landscape, you will learn about the benefits of trees in your selected location, see how planting trees will
increase the benefits provided, and map the areas where you decide to prioritize your tree planting efforts.

. = .
' : s giminyr
e 1 9012216 859 ‘ '
. - r m_' .
Step 1: Explore $ | W”f' K s .
Step 2: Benefits 202948 10 042 .

Find Location Explore Location Data See Tree Benefits Prioritize Tree Planting Generate Results




|1. Landscape, County Tree

V\O‘\“‘*V u Start on Main, then explore the map layer tabs.

Canopy Forest Health Future

Main | oiiand RISk Risk  Cilmate

Base Maps +

Boundaries +

NORTH
WESTMINSTER

Selection Visibility Settings i

Choose a boundary area to analyze:

NORTH CENTRAL
WESTMINSTER

/ US Census Block Group v @

PAIE |RJ8pa4

Northglenn
rfly Pavilion Use these tools to work with the map:

@)

« Navigate 1 Identify

EAST.CENTRAL

WESTMINSTER 125

WEST WEST |
WESTMINSTER WESTM

Stand/ej,

Thornton ‘ 4 Select ‘ O Box-Select

Federal

— (7
Heights — Geo-Swap | B Clear ’

£ Process < Start Over




|1. Landscape, County i-Tree

e Troe Berwlity

Find Locations Explore Location Data
Land Cover © Unat Display
m HiRes 200 200 Metno Eﬂ()l:h Tatile Chan m
Dula Toods Land Cover HiRes Land Cover 2011 Census Data Fores! Risk Heaith Risk Future Climate
Canopy & Impardous Forest Detalls Seas Leve Wikilte
Area Canopy Impervious Plantable Space
B % H % B % %

Remove Dataset $ Type $ Name s 0 $ Swap Highlight acra ¢ %ofall $ acre s % $ acre s % s acme s % <

1n2z1 8 10000 3001 amn 32603 2944 TA258 67,64

v Selection Total:

Data Toois ea Land Cover HiRes Census Dato Forast Risk Haalth Risk Future Climate
Developed rorest Shrubiand Herbaceous FantedCultvated Bamen Wetiands Water
Developed, Open Space
i
Remove Dataset € Type & Name £ ID & Swap  Highlight acre s %
19.12 31311 27.88 20808 18.53 8164 T7.27

v Selection Total:

Land Cover HiRes

Poputation noome Overview Home Qverview Househok! Type Home Tenure

Under 18 % Under 18 Over 64 % Over 64 Median Age Minority %
*'m| % ¢ m ¢ %

Population Under § % Under §
: : :
$ 1D & Swap  Highlight o " *
30,3830 1,774 0 554 2213 28550 8972

N/A

Selection Total:




|1. Landscape, County Tree

ACADEMY

*

Fed Lecation aplore Locabon Data See [1oe Qenelns Priontize Tree Planting Gerarale Resulls

Land Cover @ Unit Dispiay

Engitsh Tatie Chart m

Data Toots Carbon Alr Polution Ramov fyWdrokongy
Carbon Storage Carbon Sequestration CO; Equivalent Storage CO; Equivalent Sequestration
$ = $ @& $ $ m

Remove Dataset & Type & Name $ ID $ Swap Highlight H $ Shoet Ton $ Syr $ Wyr $s & Short Ton s Syr s tyr s
v Selection Tolalk 1,755.664 10,2940 44,825 2628 1,755 664 377450 44,825 2336




|1. Landscape, County

ror A Carolyn
. erg. (267)
: Ve

5 at Rock
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L

olorado Hills
Dpen Space

Canopy Legend

Minimum: 4.0
Maximum: 48.8

Lighter colors represent lower values, while
darker colors represent higher values.

prily Pa

lorado Hills
pen Space

Impervious Legend
Minimum: 32.8
Maximum: 636.2

i | [ [ [ T -

Lighter colors represent lower values, while
darker colors reprasent higher values.

erfly

i-Iree

ACADEMY

87

orado Hills
§2en Space

Plantable Space Legend
Minimum: 50.7
Maximum: 2,221.7

i [T T T T

Lighter colors represent lower values, while
darker colors represent higher values.




ido Hills
Space

Stand/ep

Per Capita Income $ Legend
Minimum: 21,201.0
Maximum: 87,371.0

Lighter colors represent lower values, while
darker colors represent higher values.

erfly

ado Hills
n Space

Stangy,
<3"/,

Poverty % Legend
Minimum: 1.1
Maximum: 19.6

min [T T T T

Lighter colors represent lower values, while
darker colors represent higher values.

i-Iree

ACADEMY




|1. Landscape, County

olorado Hills
Open Space

WEST
Carbon Sequestration Legend
Minimum: 3.5

Maximum: 42.2

o [T R =

Lighter colors represent lower values, while
darker colors represent higher values.

i-Iree

ACADEMY
ro/yn
)
"ga,e berg .
%, jerve

Avoided Runoff (MG/yr) Legend
Minimum: 0.0
Maximum: 0.4

win |1 I -~

Lighter colors represent lower values, while
darker colors represent higher values.
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|1. Landscape, County

rado Hills

Carolyn
1berg
ierve

at Rock...
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i-Iree

ACADEMY
High = Low Tree Stocking Level v
=—————°)
Importance (wesght) 25 %
High = Low Tree Cover per Capita v
—

Importance (wesght)

High Low Population Below Poverty Line
e

importance (weight)

High | Low Plantable Space

e

Impariance (weaight)



|1. Landscape, County

Canopy & Impervious Area -

1 BBO140311001
I-Tree Landscape . oeoL4L31100L
(80140312001

500 DRO140301001

- 80140300001

xecu |Ve ummary 400 BB0140300002

g DEOL40311003

= anp (80550605001

Broomfield Area 080140309003
200 80140301002

80530604002

Date: 06/01/2021 100 BO05A0603004
(80550604003

Iandscape. ifreetools.ong — e — ||l|n||mlv!mL|Jm || | 080550604001
Version- 4.3.1

Prioritization Total Area
Poverty {High Resolution UTC)
o 0 DA0140311001
Superiar :,n»r].;y;.ll':‘ ey . 2RO CB0140312002
e BE0140312001
atRock Da0140301001
000 (0140300001

80140300002
080140311003
CEO5S0605001
DB0140305003

i

- e DB0140301002
2 % (0590604002
—5'. ATHCENTRAL S DROSS06HI00A
G (0530604003
worado Hidls tortent i | | 4 | | | BHASS0604001
Open Space erfly Pavilion

{s)

=)

Thornton Canopy & Impervious (2011 NLCD)

oy

Federat
Heignts

Araa Canopy Impervious Plantable Space

acre ¥ %ofall $ acre 2 % 2 acre 2 0% % acra @ % 2

Selection Total: nzve D0g0. 3001 2T 32663 70044 7.525.3

VI‘I‘H“‘



Today’s 1-Tree Core Topics

v 1. Design, MyTree, Species, Planting

v 1l. Landscape, County

[11. Canopy

1VV. Eco, Harvest

V. Application (CO FAP, Citizen Science)



1. Canopy

For forests and many trees: I-Tree

® i-Tree Canopy (web app) Easily estimate tree canopy and benefits using aerial photographs. see Canopy report example

ACADEMY

Welcome to i-Tree Canopy! 71

Estimate tree cover and tree benefits for a given area with a random sampling process that lets you easily classify ground cover types.

s Select from existing geographic boundaries, draw your own project area boundaries onto Google Maps, or load an ESRI shapefile.

* You can use multiple, non-overlapping boundaries at the same time.

» i-Tree Canopy randomly generates sample points and zooms to each one so you can choose from your pre-defined list of cover types for that spot.
* \With i-Tree Canopy, you review Google Maps aerial photography at random points to conduct a cover assessment within a defined project area.

= 500-1000 survey points are suggested; the more points you complete, the better your cover estimate for your study area.

» |f estimating tree cover, tree benefits can also be estimated.

¢ |Learn how i-Tree Canopy works.

» Video Learning Resources

https://www.itreetools.org/tools/which-tool-should-i-use

I-Tree Academy

Online Training
i-Iree March 3rd — June 2nd, 2021



https://www.itreetools.org/tools/which-tool-should-i-use

1. Canopy i-Tree

ACADEMY

P —— E—

. : Just curious? Dive right into survey mode with an
Ma Satellite |
p 'y Jl  existing project.
T R T TS T ”
oA SRR N A 759
. - Y éy : o =
. T SRR Rt Launch Our Example Project

Ready to survey your own area? Use these
functions to map your project boundaries.

US Boundaries v

UK Boundaries v

‘ Im | oad Shapefile Boundary ’

# Draw Boundary

N ,( Work with map boundaries

‘ { Select ’ [i] Delete '




1. Canopy

Cover Class

=2 View Results
| Add New Point
A
1
Cover Class
Impervious Road v

Latitude 39.0919022370017

Longitude -108.5800124%574

Save & Create New

Save your PrOJect

' ..

Map data $202) kmagery 2021 | Terms of Uze m-mm



1. Canopy i-Tree

ACADEMY

Cover Class

View Results
Add New Point
ID
1

Cover Class

Latitude

Longitude -108.54667949316

Save & Create New

— | Save your Project

| B Save ‘ Save often - don't lose your datal

0 Imagery #2027 Terms of Use  Repdrt & map wior




1. Canopy

Cover Chart

i-Iree.

ACADEMY

% Covered

Area Covered (mi+)

Grass/Herbaceous: 7.8%+3.92
Impervious Buildings: 17.6%+5.88
Impervious Other: 21.6%+5.76
Impervious Road: 11.8%+4.80
Soil/Bare Ground: 23.5%+5.94

Tree/Shrub: 15.7%+5.55

Water: 2.0%+1.96




1. Canopy i-Tree

i-Tree Canopy v7.1 B W e

ACADEMY
Cover Assessment and Tree Benefits Report
Estimated using random sampling statistics an 6/1/2021 _i-Tree,
Tree Benelit Estimates: Air Pollution (English units)
Babe Descnption Amownt oz} oSt Clee (USDN 45T
[xe] Cartion Monguge iemsonved arously 300 0.0 0 =0
"o FN0gen (ode o s, 4 =000 W =h
(=3 Omre wecoes wrrusl oo 700 w 0
908 Suler Dosde semoved anuly Q00 =000 ) =0
mas Partzisate Mo ez thart 13 mcroms removed arncedy am =000 w =0
Ll Portosiats Myt goagter thawt 2.5 miaons 30n) oz than 10 escrons semosed o 2000 50 =0

Iree Benefit Estimates: Hydrological (English units)

Atroust (00

Avccinet Bunct! o
Exaponaton
Ba
Fvpraon
Peterm Eraponstion
Potermal Dagctrampiaton

Land Cover

b L L e e

tondond 800 ¥ soresed deel chanad

T 0000 @ WA [ 5 0000 0 KA 1 35T D000 © MiA Sighih wots 65 = Sunced W o
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- smi= E | | Impemfous Buildings
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Today’s 1-Tree Core Topics

v 1. Design, MyTree, Species, Planting

v 1l. Landscape, County

v 111. Canopy

V. Eco, Harvest

V. Application (CO FAP, Citizen Science)



1. Eco

Fdr forests and many trees:

e Tree

Fco (desktop app) Flagship tool that quantifies the structure of, threats to, benefits, and values provided by forest populations globally.
p app) riagship ] P y pop 8 Y

. i-Iree
-Tree Eco Complete |

Inventories

June 26, 2019

The Eco complete inventory option is a flexible and scalable choice that can be used to assess ecosystem services
for a single tree in your yard or for assessing thousands of trees in a street or park tree inventory.

Examples of projects that are suited for the Eco complete inventory option include parks, corporate or college
campuses, apartment complexes, cemeteries or other individual properties.
https://www.itreetools.org/tools/which-tool-should-i-use

I-Tree Academy

Online Training
i-Iree March 3rd — June 2nd, 2021



https://www.itreetools.org/tools/which-tool-should-i-use

1. Eco, Harvest

What does Eco provide?

i-Tree Eco provides extensive forest and individual tree analyses including the following:

Functional Analyses:

Pollution removal and human health impacts

Carbon sequestration and storage

Hydrology effects (avoided run-off, interception, transpiration)
Building energy effects

Tree bio-emissions

Avian habitat suitability (plot-based projects; limited to 9 bird species) A

Report Example

Ultraviolet radiation (UV) tree effects UV Report Example

Structure and composition analyses:

Species condition and distribution
Leaf area and biomass
Species importance values

Diversity indices and relative performance

ian Habitat Suitability

i-Iree.

ACADEMY



1. Eco, Harvest .
“Tree,

Forecasting modeling options including: DENY
e Tree planting inputs
e Extreme event impacts for weather and pests
e Annual mortality adjustments
Management information including:
e Pest risk analysis
e User defined optional fields
e Cost benefit analysis

Eco Report Examples - Springfield MA Squares

These are examples of exported structural, benefit analyses, individual level PDF reports from a

demonstration project applying Eco to (2) small public squares. You will not need Eco installed to view

examples of these reports.

e Springfield Square report examples: Springfield Eco zip file package (6.3mb)

Who is using Eco?

Thousands of people in the United States and internationally have used Eco for projects ranging from

small tree inventories to regional scale assessments. Eco users include government agencies,

consultants, nonprofits, universities, researchers, volunteers, educators, advocates and more.




1. Eco, Harvest

i-Iree.

ACADEMY

i-Tree Eco Model Basics

i-Tree Database for New User Data

City Data [ Pollution Data [ Weather Data ]

1 .

Location Data ]

l

https://www.itreetools.org/support/resources-overview/i-tree-methods-and-files

i-Tree Academy PPT Slide



1. Eco, Harvest

i-Iree
ACADEMY
Eco tree data variables
Minimum Required Tree Data  Optional but Recommended Tree Data Energy Effects Data
* Treespecies * Total tree height (optional but not available for all
* Diameter at breast height * Height to live top e g Iocations)
(DBH) « Height to crown base N .
_ * Direction to a building from

* Crown width (N-S & E-W) thatree

* % Crown missing * Distance to a building from a

* Crown health % dieback (condition) tree

* Crown light exposure (CLE)

* Land use

i-Tree Academy PPT Slide



LS
& Unetad States Department of Agricudesse

Understanding i-Tree:
Summary of Programs and Methods

1. Eco, Harvest <

DERIVED
VARIABLES

i-Iree.

-V 1 SERVICES
ECOSYSTEM SERVICES ACADEMY

Eco tree data -
. 5| 8
variable 1EE .
: : | |3 e | o $| 2
v =
relationships SE IR IR
s | E|2|8|2|E|5|S|5|2|2|2|¢
2128|s|S|5|5|12|8|3|5([%8|¢2|é
FA60 2L s|3(8|8|5|F|2|3|8[8|E|E|E
Understanding i-Tree DIRECT MEASURES S| 3|08[o|z|a|<2|<|~|5[C0|=2|5
milseces |00 (0000 oo
' | Diameter at breast height ‘
| dbh) oD |D D
| Toai heigh clclec]o
| Crown base height D D C
' | Crown width D | D |C
Tree . , , |
\Varia b ' es | Crown light exposure € D
Percent crown missing C C

i Crown health (condition/
dieback)

: Field land use

| O |n|O

' | Distance to building

|
|
\
l
[
|
—_ | Direction to buiiding

Percent tree cover
Plot Percent shrub cover

Variables Percent building cover

Ground cover composition

Table 2.—Summary of which directly field-measured characteristics are used to estimate derived . d lid
variables and ecosystem services. D= directly used; I= indirectly used; C= conditionally used. i-Tree Academy PPT Slide



1. Eco, Harvest

i-Tree

aOul

Download

Feb. 24, 2021

Thank you for your interest in i-Tree! Use one of the links below to download the latest installer for the i-Tree suite of tools.

Select the appropriate link below to access the download form and receive your download link by email . Note to previous i-Tree users: i-Tree
accounts are no longer needed for this process! The file you are downloading will auromatically launch a Windows Installer for the i-Tree Desktop
tools. The web-based i-Tree tools (i-Tree Canopy, etc.) do not need to be downloaded and installed.
e i-Tre 21_6.1.36.exe (use this to install directly on a Windows-based PC)
o Ifyou have trouble actually saving the download after clicking on the link emailed to you, you may need to temporartly disable Controlle
lccess in Windows.

o i-Tree 2c 6.150 (use this if you need to create a CD or DVD that can be used ro install i-Tree onto Windows-based PCs)
i-Tree is supported through a cooperative agreement among the U.S. Forest Service and other organizations. By filling out the download form you
will help us assess interest in the i-Tree Tools and inform future funding allocations. Once you complete the form you will receive a download link

by email from itreetools.org. Please make sure your spam filters allow email from this address and please check your junk mail folder if the email is

late in arriving.

Video i-Tree desktop software download and installation — Al Zelaya, i-Tree Academy

https://www.youtube.com/watch?v=B EUQ 4i198
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1. Eco, Harvest

Project Configuration Data  View  Reports = Forecast  Support

Eo> 2 LE BE B & Bmego..t BEI

Project | SubmtData  Track & Written Compostion  Benefts  Indiidual A Qualty Heath  Pest  Polutionand | Metric | Scientific | | Comments Ma SV KML
Metadata for Processing Retrieve Resuls | Report and Structure ~ and Costs~ Level Results« Impacts and Values- Analyss.  Weather« Notes Report (beta) (beta) (beta)
Formatted Reports Charts Settings
| Help

Reports > Formatted Reports > Written Report

O3 Q-0%% @ 00@rpe1 od%Q00 @ -0- DADMA [8]an
.-n-‘:n-n-‘Z-n-u-!n-l--n-iun-nS-»-n-nS---n-n?u-n-u-

Reports > Formatted Reports > Written Report

The Written Report seen in the action panel to the right is 2
summary, narrative report that provides a discussion of the
following results of your project:

*  Tree characteristics of the urban forest

¢ Urban forest cover and leaf area

o Ec services (air polluti |, carbon storage,
etc)

o Structural and functional values of trees

* Potential pest impacts

¢ i-Tree Eco methods

UGA Campus Arboretum

Notes:
*  Some analyses included in the Written Report may not be
available because of decisions not to collect certain variables
in the field or data limitations in the case of international :
studies. :
» If you make changes to your project settings or add or edityour = &
field data, you will need to send your data to the server and B
load your results again to ensure that your changes are %
reflected in your reports.
*  Use the toolbar at the top of the action panel to zoom in and out | -
and save or print the report you have open. s
*  You can change how units (English or metric) and species
names (commaon or scientific) are displayed in your reports by
clicking on the appropriate button in the ribbon abave.

Urban Forest Effects and Values
June 2021




Summary

Understanding an urban forest's structure, function and value can promote management dedsions that will improve
human heaith and environmental quality. An assessment of the vegstation structure, function, and value of the UGA t Traa
Campus Arboretum urban forest was conducted during 2011 Data from 8056 trees

Arboretum were analyzed using the Tree Eco model developed by the U.S. Fc Reports > Formatted Reports > Written Report

Station.
The Written Report seen in the action panel to the rightis a

Number of treas: 8,056 summary, narrative report that provides a discussion of the
following results of your project:

e TresCover:169%

e Tree characteristics of the urban forest

* Urban forest cover and leaf area

e Ecosystem services (air pollution removal, carbon storage,

* Most common species of trees: lagerstroemia spp, Red maple, Loblolly pine

= Percentage of trees lessthan 6" (15.2 cm) diameter: 509 %

etc.)
= Pollution Removal: 2.635 tons/mr(S‘_S3 mougrﬂ/veaf) b Structural and functional values of trees
e Potential pest impacts
e (Carbon Storage: 2.724 thousand tons ($362 thousand) e i-Tree Eco methods

e (Carbon Sequestration: 85.22 tons {$11.3 thousand/year) Notes:

* Some analyses included in the Written Report may not be
available because of decisions not to collect certain variables
in the field or data limitations in the case of international

= Oxygen Production: 227.3 tons/year

* Avoided Runoff: 197.4 thousand cubic feet/year (5132 thousand/year)

studies.

«  Building energy savings: N/A — data not collected e If you make changes to your project settings or add or edit your
field data, you will need to send your data to the server and

e Avoided carbon emissions: N/A — data not collected load your results again to ensure that your changes are
reflected in your reports.

* Structural values: $10.6 million ® Use the toolbar at the top of the action panel to zoom in and ou
and save or print the report you have open.

Ton: smortton (US| (2,000 =x) g ‘ g "

Monetary vakes § srereported in US Dolen th 0 ugnost the jeport except wherenoted e You can change how units (English or metric) and species

Eoosystem seny os astmates sre O OTIes f0r Tees names (common or scientific) are displayed in your reports by

clicking on the appropriate button in the ribbon above.

For an overview of i-Tree Eco methodology, see Appendix |. Data collection qualit
collectors, over which i-Tres has no contral,




1. Eco, Harvest .
i-Tree

PrgectConfgurton Daz Vew ReoS  forgs Seppot ACADEMY

! ;o . = N C

e o - CE & & - = & [eegisn] (commen| -~ B ®©¢

P Scbrf Do X Wtten | (ooposhos | Benefz bhdwdal Ar Qaaity Haath P Polummoard  messe Soentic Mooe :
Retadats for Processng Hots Repom and Stuctise - and Costs. Level Reqlts. opacts and Vaiss . Arahes - Weather. Notas

| Strcture Semmary | - —
Hep < L
o 5 > Written Report

feports » Formatted Reports > Written Report By Statum and Speces

The Whittes Repert seen in the action panel to the rig Populanon Summary
Surerrary, sarative report that provides a deussiad By Speces
following results of your projct

PPl %P9 D-2-' DADH AN

By Stuatum
*  Tree characteristics of the arban forest By Suatu= ser Unt Area
*  Urtas forest cover and fexd area
*  Ecosystem services {ar poliuSion removel d
e Speces Distrbution
*  Stractural and fuscliona’ values of bees = =
o Potercal pest imsacss By DBH Cass (Cant
* TresEcomethods By DB= Cas (et Tz E @
Notes: By DB+ Cass (horaontal t2 M Quay Heath Pest
®  Some aralyses isciuded in the Writen Recort md 8y DB Cass 200 Statum 5« IO g Vs - Asghss o

evainble because of decisions not to coflect cer]
e e : B BB s 20t Sesiem thavemerzeabioy I

Sraet Trees by Stratum

Structure Summary by Species

droject: UGA Carr Arboretum. Series: Cam wentory, Year 2011

i-Iree

Average
Trees Leaf Area Leaf Biomass Tree Dry Weight Biomass Condition
Species Number SE (ac) SE (ton) SE (ton) SE (%)
lagerstroemia spp | 581 +0 6.574 +0.000 | 3.796 +0.000 97.237 +0.000 | 9405
Red maple 435 +0 19.749 +0.000 5933 +0.000 126.666 +0.000 94.17
Loblolly pine | 416 +0 34.003 +0.000 | 12304 +0.000 | 229639 +0.000 | 8963
Flowering dogwood 406 0 3.774 +0.000 1308 10.000 33.812 +0.000 9226
River birch 379 £0 16.095 0.000 | 5565 0.000 | 85.035 +0.000 | 90.10
Willow oak 367 +0 38.716 0.000 15322 +0.000 368928 +0.000 97.02
Southern magnolia | 27 0 23.760 +0.000 | 14315 $0.000| 271548 40.000 | 9503
Tulp tree 315 +0 14.056 +0.000 3.696 +0.000 66.952 +0.000 93.76
Water oak | 314 +0 70.973 +0.000 | 29939 #0.000] 1,096.491 +0.000 | 9172
Eastern red cedar 224 0 4576 +0.000 5672 +0.000 42303 +0.000 | 9358
Texas red oak 152 0 3534 +0.000 | 1549 +0.000 | 31339 £0.000 | 9662
Overcup oak 146 +0 17.081 +0.000 7.487 +0.000 150924 +0.000 94.12
Eastern redbud | 140 +0 1.598 +0.000 | 0457 £0.000 | 9.205 £0.000 | 9087
Sweetbay 125 +0 0.676 +0.000 0431 +0.000 4360 +0.000 9389
Topal holly 123 +0 1535 +0.000 | 0915 +0.000 | 32035 $0.000 | 9365




byartory 03ts Iovartory Vaue | Racort Oases Bt .
| Work weh Tree daa |3 1- ree
On this tab, you can enter the data that you collected in the field and recorded using either paper forms or 3 mobile device. You can also adit or view data Rt
To get staeted, go 20 the File menu and sefect one of the following . » that has already been entered. On the ribbon above, there are six groups of available functions, indhuding: ACADEMY
ogtisns .
< M Pojert - ciiane s new o project Data Collection - to view and print forms i you are using paper forms for recording data collectzd in the field, To submit your project settings to the web
«  Open Project - 10 open an existing Eco project \ or retrieve your data from the web if you are using a mobile device for recording field data. To activate the import function, diick on the Trees button,
* Open EBxample Project - to open and explore an exampie
praect provised by Eco Inventory Data - 1o manually add the data that you colfectad in the field or edit/view data that has siready been added.
Choose from the available tabs at the fop of the ribbon bar to Inventory Value —to adjust benefit prices and add annual cost data.
access the farent phases of an Eco project Within each tab, you
can ciick on one of the functions or buttons in the ribbon above The
feature that you chocse will awaifable in the action penel 1o Report Classes ~ 1o view D8H and Crown Health classes that will be displayed in reports.
the right.
Export - t0 export an open data table to 3 “comma sepsrated values™ {csv) or “keyhole markup language” {kmil) file.
Editing Mode - to turn Editing mode on.
“IMPORTANT®
After you send dats and retrieve results on the Reports tab, the Editing Mode function will become available on the Data tab [i.e., it will no longer be
greyed out 2nd the function will read “Editing Mode: OFf"). This indicates that, with the exception of the Benefit Prices and Aanual Costs functions, the
tab is in View-only mode 5o each function may be viewed, but not editad. The Benefit Prices and Amnual Costs functions may be edited at all times.
In order to edit data in the rest of the tab, you will need to switch to Editing mode by dicking on the Editing Mode function once it has become available.
After clicking on it, the function will be greyed out and read “Editing Mode: On." Edits may be made 2t that time. Please note that If you edit your data,
Data > Inventory Data > Trees
i Stratu Land DBH 1:
m Crew Survey Date Status Speces Address Use Photo ID DBH 1 (in) Height ()

TIV2012 120000 AM | Plarted Flowesng dogwood (Comus flonda) Instituional
(1171172012 12.00.00 AM | Planted Flowering dogwood (Comus flonda)
1171172012 120000 AM Plarted | Tulp tree (Liiodendron tulpfera)

(1112012120000 A Plarted | Tulp tme (Linodendron tulpfera)

11/11/2012 120000 AM Parted | Overcup osk (Guercus hyata) ‘ ' ' 270,

Crown: Crown: Crown: Crown: Street

Total S0
Height (ft) ::s;ht ) mﬁ) ‘ 9% Missng Lght Exposure ~ Tree?

%-5% |3 Sdes
% |5 Sdes
0% |5 Sdes
% |3 5des




Data > Inventory Value > Benefit Prices

Adjust your Benefit Prices (advanced users)

Notes
« The Defouit voiues are those gvowabie ot the tme of softwove instaliotion .
o If you leave o vaiue bignk, the most current cefault value will b2 used for processing anc cispioyed in the footnstes of reports l_Tree
o Aiternanvely you may enter your own values if you know them —
o For future reference. use the CSV EXPOIT Dution in Thg niddon SOOVE 10 Save your current waiues SEFORE changing them ACADEMY

 You may change the volues Deiow ond Lpdate their associared Repart outputs WITHOUT resubmitting your entire £20 project
Measurement Units: English

Benefit Prices
Electricity in § (USD)/kWh: | 0.10}
Heating in $ (USD)/therm: | 158/ | Defat
Carbon in § (USD)/ton: [ 13304 | Defmat
Avoided Runoff in $ (USD)/galion: | 0008936) | Defock

For any prices left blank above, and other values such as Pollution Prices, the most current values will be used for processing,

Data > Inventory Value > Annual Costs Data > Repo rt Classes > Crown Health
Enter the costs associated with your project

Nor'e;;” future reference, use the CSV Export button in the ribbon above to save your current values BEFORE changing them. Hea Ith C'asses are used for R E PO RTl NG

» You may change the vaiues beiow and update their associated Report outputs WITHOUT resubmitting your entire Eco project.
Public $ (USD Private $ (USD| Total $ (USD, ' | 5

Planting $ (USD): | et | ! )o| e 0 ID Description Z(;Dlebad(

Pruning $ (USD): [ 0] | 0| 0

Tree Removal $ (USD): | 0] [ 0| 0

Pest Control $ (USD): | 0| [ 0| 0

Irrigation $ (USD): [ 0| | 0| 0

Repair $ (USD): [ 0| [ 0| 0

Cleanup $ (USD): [ 0

Legal $ (USD): [ 0

Administrative $ (USD): | 0

Inspection $ (USD): | 0

Other $ (USD): | 0

Total Costs $ (USD): 0




Air Quality Health Impacts and Values by Trees w
e e I-Tree X
[ NO2 03 PM2.5 s02
’ Inddence Value Incidence Value Inciderce Value Incidence Value
|__(Reduction /yr) ($/yr) __Reduction/yr) /v | (Reduction/yr) (8/yr) __Reduction/yr) $/¥)
Acuta Bronchitis | | 0000 002 4
Acutas Myocardal Infarction | 0.000 L e l_Tree
Acute Respiratory Symptoms | 0.008 028/ 0531 59.08 0183 a7 0.000 oot S N
Asthma Exacerbation [ 0.124 10.36 0087 7.04 0.003 023 ACADEMY
Chronic Bronc hitis ’ | 0000 ne
Emergency Room Visits 0.000 0.07 0.000 013 0.000 0.06 0.000 0.01
Hosptal Admasions | 0.000 13 0.001 %78 | 0.000 0866
Hospeal Admssions, Cardiovascutar | | 0.000 2.20
Hosptal Admasions, Mesprratory | I | 0.000 139
Lower RBespiratory Symptoms | | 0002 012
Mortality I | 0.000 187050 0.000 2anar|
School Loss Days | 0.164 1614 |
Upper Raspiratary Symptoms | | | 0002 008
Work Loss Days | | 0.032 438
Total | 0134 2458 0.857 197264 0.308 24406 0.003 091
EPA Environmental Benefits Mapping and Analysis Program http://www.epa.gov/airquality/benmap/index.html
Incidence: the total number of adverse health effects avoided in a year due to a change in pollution concentration
Value: the economic value that is associated with the incidence of adverse health effects
Susceptibility to Pests by Stratum W
Llocation: Athens-Clarke County (balance), Clarke, Georgia, United States of America
Project: UGA Campus Arboretum, Series: Campus Inventory, Year: 2011 >
Generated: 65/1/2021 1 Tree
Number of Trees Structural Value ($) Leaf Area (%) Leaf Area (ac)
Not Not Not Not
Pest Name Stratum Susceptible Susceptible Susceptible Susceptible Susceptible Susceptible Susceptible Susceptible
Aspen Leafminer Campus 5 8,051 6,649 10,627,812 01 959 0s 4908
Asian Longhorned Beetle Campus 1275 6,781 1044451 9,590,011 118 882 58.2 4333
Beech Bark Disease Campus 10 8046 17,911 10,616,550 01 949 07 4807
Buttemut Canker Campus 5 8,051 14,293 10,620,168 01 99.9 0.5 4910
Balsam Woolly Adelgid Campus 0 8056 0 10,634,462 0.0 100.0 0.0 4915
Chestnut Blight Campus 0 8,05 0 10,634,462 00 100.0 0.0 4315
Dogwood Anthracnose Campus 446 7510 118,070 10,516,391 08 992 4.1 4873
Douglas-fir Biack Stain Root Campus 1 8055 1,366 10,633,09% 00 100.0 0.1 4914
Disease
Dutch Elm Disease Campus 58 7998 93,720 10,540,741 13 987 65 4850
Douglas-Fir Beetle Campus 1 8,055 1,366 10,633,096 0.0 100.0 0.1 4514
Emerald Ash Borer Campus 12 8044 10,622 10,623,840 02 998 0.8 4307
Fir Engraver Campus 1 8,055 1,366 10,633,09 0.0 100.0 01 4914
Fusiform Rust Campus 418 75638 767,590 9,866,871 7.0 93.0 ua 4571
Gypsy Moth Campus 2,268 S,788 8,722,673 4,911,789 55.1 445 2708 2206
Goldspotted Oak Borer Campus 0 8056 0 10,634,462 0.0 1000 0.0 4915




1. Eco, Harvest

.
ampus Arboretum : Campus Inventory] [Year: - i-Tree Eco vo. . o
— PRTE P 1| 1 -
u Project Configurston  Dsta  Vew  Reports  Foreest  Support ACADEMY

) No & @ 3

Project Land Crown Project & S\ Edting
Defintion Use Health  Stratz Ares Mode: Off
| Help 2

On this tab, you can set up your new i-Tree Eco project or make ¢
To get started, 20 to the File menu and select one of the following there are five groups of available functions (see Notes below), il

* New Project o create a naw Eco project.

* Open Project-to ?oen an existing Eco project. _ Defil Please select the project type: IP"* Sample = I Fiel
* Open Example Project - to open and explore an example f
1Complete Inventory
project provided by Eco. Plot Sample o r——
Proj{ ptre
Choose from the available tabs at the top of the ribbon bar to the ¢ Aplot-based sample project is one in which you must
access the different phases of an Eco project. Within each tab, you measure a set of randomly generated plots throughout your
can click on one of the functions or buttons in the ribbon above. The £ study area. You must collect data for all of the trees in your "
feature that you choose will become available in the action panel to XPE iplots. This type of project is most applicable to the analysis va
the right. of a broad, diverse landscape, such as a city or large

Editi luniversity campus where it is impractical to measure all

trees. Piot sample type projects do include calculations of

i sampling error which results when only a subset of the

population of interest is being measurad.

Afte ne

will | Notes:

view e Data import is only enabled for complete inventory
projects and is not possible for plot-based projects.

Whe * You cannot change between Complete inventory and

switl Plot Sample projects once you click OX so be sure to
select the correct project type

read

- (o] o

* Functions that are greyed out on the ribbon cannot be acces
mere information about your project, additional functions v




Today’s 1-Tree Core Topics

v 1. Design, MyTree, Species, Planting

v 1l. Landscape, County

v 111. Canopy

v V. Eco, Harvest

V. Application (CO FAP, Citizen Science)



11. Application

CO Forest Action Plan

GOALS AND STRATEGIES

GOAL #1

A\
gl

CONSERVE

W

PROTECT

N,
P

PROMOTE THE ROLE

AND INFRASTRUCTURE
DEVELOPMENT OF URBAN
AND COMMUNITY FORESTS
TO ADVANCE PUBLIC HEALTH,
WELLNESS AND SAFETY

Improving and enhancing urban
living environments through healthy
and resilient community forests is a
cost-effective tool that contribute
to positive health outcomes.
Strategic planning related to
population density and growth,
green and gray infrastructure,
expansion of the wildland-urban
interface and the enhancement
of public spaces will maximize
community and ecosystem
sustainability.

STRATEGY 1: Master planning
efforts that include urban and
community trees and forests need
to occur at city, regional and state
scales.

Approaches

1. Increase overall urban canopy
to reduce impacts of urban heat
sinks and stormwater flow while
improving air quality

2. Engage in community planning
efforts including public and
private tree inventories,
monitoring, planting to increase|

urban canopy, selection of
climate-adapted species, prope|
maintenance schedules and
continuous hazard tree remova

3. Reduce landscape fragmentation

by creating green infrastructure
corridors

4. Alter forest structure and
composition to reduce risk or
severity of wildfire, focusing on
the wildland-urban interface

STRATEGY 2: Develop resources
and tools to improve and highlight
the positive and synergistic
relationships among green
infrastructure, forest, trees, and
public health and wellness.

Approaches

1. Inventory private and public urban

and community forests to monitor
ecosystem services with the

i-Iree

ACADEMY

THEME: URBAN FORESTRY

U.S. Forest Service Urban Forest
Inventory and Analysis (UFIA),
CO-Tree View and/or i-Tree

Reporting Protocol
STRATEGY 3: Expand
opportunities for collaboration

among residents, collaboratives,
agencies and other sectors.

Approaches

1. Create redundancy of habitat
types, riparian areas and refugia
on the landscape

2. Connect existing tree-affiliated
groups and organizations through
electronic resources

https://csfs.colostate.edu/media/sites/22/2020/10/2020-ForestActionPlan.pdf
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11. Application
CO Forest Action Plan

GOAL #2

ENHANCE

PROMOTE AND INCREASE
PUBLIC AWARENESS,
LEADERSHIP DIVERSITY AND
EQUITY WITHIN THE URBAN
FORESTRY COMMUNITY

Current and projected changes in
Colorado’s demographics require
understanding and engaging
different perspectives, cultures,
genders and ages. This broadens
economic and social opportunities
while building and strengthening

i-Iree

ACADEMY

communities. Understanding the
critical importance of community,
economics and ecosystem benefits
protects, conserves and enhances
the urban and community forests of
today and tomorrow.

Approaches

1. Identify current urban forestry
education programs and
organizations responsible for the
programs (e.g., Project Learning

outreach programs to ensure the
largest impact on students and
communities

STRATEGY 2: Increase
engagement of underserved and
minority communities within urban
STRATEGY 1: Create, maintain and community forestry.
and enhance educational programs
that focus on urban and community

forests.

of urban-forestry-focused
organizations (e.g., Colorado Tree
Coalition)

Approaches
1. Identify underserved and minority

3. Coordinate with state agencies communities within Colorado that

that provide education and

would benefit from urban and
community forestry programs




11. Application
CO Forest Action Plan

i-Iree

ACADEMY

GOAL #2 2. Determine existing programs STRATEGY 3: Increase workforce
to increase engagement (e.g., development opportunities and
WAL, Project Learning Tree) and assess J green jobs.
- .”' ;r:|'- the need for additional programs
\. 3. Translate existing English Approaches
ENHANCE publications into Spanish and 1. Inventory private and public urban

forests to monitor ecosystem
services with the U.S. Forest
Service Urban Forest Inventory
and Analysis (UFIA), CO-Tree View
and/or |-Tree

other languages as needed

4. Partner with professional groups
like the International Society of
Arboriculture and the Society
of American Foresters to host
training events in Spanish

2. Research and develop alternative
renewable biomass energy
markets and resources

3. Provide education about forestry
careers through Project Learning
Tree’s Green Jobs curriculum



11. Application

CO Forest Action Plan

GOAL #3

A
4

CONSERVE

W

PROTECT

IMPROVE AND ENHANCE
ECOSYSTEM HEALTH

AND BIODIVERSITY FOR
LONG-TERM RESILIENCE

BY INTEGRATING URBAN

AND COMMUNITY FOREST
MANAGEMENT, MAINTENANCE
AND STEWARDSHIP INTO ALL
SCALES OF PLANNING

A dynamic green infrastructure
provides residents, cities, towns and
municipalities with a sustainable job
market, stormwater management,

improved habitat, quality drinking
water, energy conservation, and

T ACTION PLAN

enhanced public health, wellness
and safety.

STRATEGY 1: Sustain or restore
fundamental ecologlcal functions.

Approaches

1. Increase forest species
biodiversity, structure variability,
and tree health and resilience to
disturbance and climate change

2. Maintain and restore hydrological
functions and riparian areas

3. Monitor the introduction of
invasive species and mitigate

existing invasive species

4. Reduce landscape fragmentation
by creating green infrastructure
corridors

STRATEGY 2: Enhance carbon
storage to mitigate greenhouse
gas emissions and support climate
change resllience, restoration and
sustainability within urban and
community forests.

Approaches
1. Increase overall urban canopy
to help offset greenhouse gas

i-Iree

ACADEMY

emissions and lower energy
demands for heating and cooling
buildings

2. Revegetate sites after natural and
land-use conversion disturbances

3. Increase species blodiversity,
structure variabllity and individual
tree health

4, Select species that match
projected climate and site
conditions

5. Realign significantly disrupted
ecosystems to meet expected
future conditions




A Short Note on I-Tree & CO TreeView

i-Iree

ACADEMY

You inquired if i-Tree can accumulate statewide data for access? The short answer is no for the off-the-shelf i-Tree tools.

The core i-Tree applications are limited and designed for use for individual community, city and regional projects scales. Therefore, they
would be limited for statewide assessments due to the amount of data. | have seen the Colorado Tree View tool which stores and makes
many community tree inventories available for public access and I believe that is a PlanitGeo developed platform. Other states like
Wisconsin and lowa have similar tools for sharing statewide community inventory data, and some estimate ecosystem services. | don't
know how the PlanitGeo underlying system works specifically but in many cases statewide tools using i-Tree derived estimates work off a
webservice that generates ecosystem services based on i-Tree application methods, and then serves up estimates up on the fly in an online
interface. So, this is somewhat of a customized process working directly with i-Tree Development systems or companies like PlanitGeo
may develop their own processes for integrating and generating i-Tree estimates on the fly.

As for the core i-Tree Tools, there is not currently a way to import very large amounts of community tree inventory data into the Eco
application for an assessment of dozens of communities. The underlying Microsoft Access database structure of i-Tree Eco has
import limitations due to memory and it can't handle large amounts of data beyond 300,000 trees depending on the types of data
variables. In the future as the platform and systems improve, there may be more opportunities to work with statewide data.

Otherwise, tools like i-Tree Landscape have some capabilities at large scales but there are limitations and advantages to consider when
assessing trees and forests using aerial assessment tools, which we will learn about on the 31st.




Which Tool Should | Use?

May 12, 2020

For forests and many trees: ACADEMY

e i-Tree Eco (desktop app) Flagship tool that quantifies the structure of, threats to, benefits, and values provided by forest populations globally.

® i-Tree Projects (web app) An online platform for sharing results and data from i-Tree Eco assessments. Currently in beta - additional projects
coming soon!

e i-Tree Landscape (web app) Rapidly assess human and forest population information; threats to help prioritize areas for tree planting;
protection.

® i-Tree County (web app) Quickly learn the numerous benefits that trees provide within your county.

® i-Tree Canopy (web app) Easily estimate tree canopy and benefits using aerial photographs. see Canopy report example

For individual and small amounts of trees:

® i-Tree Design (web app) Parcel level analysis of current and future tree benefits.
® i-Tree MyTree (web app) Easily assess the value of one to several trees in a mobile web browser.

For effects on stream flow & water quality:

e |-Tree Hydro (desktop app) Quantify the effects of tree canopy and impervious cover on water quantity and quality.

For recommendations on what species to plant:

e i-Tree Species (web app) Determine the best species that meet your desired benefits.

For benefits of new tree planting projects:

e i-Tree Planting (web app) Estimate the long-term environmental benefits from a tree planting project.

For carbon stored in harvested wood products:

e i-Tree Harvest (web app) Estimate the amount of carbon stored in harvested wood products.

https://www.itreetools.org/tools/which-tool-should-i-use
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Thank You!
Thoughts & Questions?

i-Iree

i-Tree
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Learn about i-Tree

More than beauty and shade, trees work hard for us all. Explore how trees

improve the environment in communities big and small, urban and rural...

even in your own backyard!

. Arbor Day ETY OF MUNICIPAL
Proven Solutions for a Growing World Foundatio.n A R BORISTS

https://www.itreetools.or
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